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Program Environment: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OT DRAW LAYOUT: 
 
 
There are a number of key sections in the OT Draw environment. The canvas in 
the middle of the screen is surrounded by 4 toolbars. 
 
Located at the top are 6 menu items (File, Edit, Draw, Tools, Format and Help) 
that contain additional features and settings. 
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Drawing Region: 
 
 

Item 
 

 

Description 
 

The Canvas: 
 

Diagrams are drawn in this area. 
 

 
 
 

Toolbars: 
 
 

Item 
 

 

Description 
 

Parameter Toolbar: 
(Top) 

 

Adjusts project parameters, font parameters or drawing 
parameters. 
 

 

Drawing Toolbar: 
(Right) 
 

 

The collection of available drawing tools including shape, 
labelling and bathroom tools. 
 

 

Canvas Toolbar: 
(Below) 
 

 

Edit the canvas by adding, deleting, renaming or clearing 
the canvas. 
 

 

Module Toolbar: 
(Left) 
 

 

Shift between different modules (ie: the different types of 
diagrams drawn) 
 

 
 
 

Specific Features: 
 
 

Item 
 

 

Description 
 

Scale Factor: 
(Parameter Toolbar) 

 

Displays the scale you are currently using. Change this 
value to zoom in and out. The value changes to a 
percentage for bathroom templates and picture designs, 
as these are not drawn to scale. 
 

 
 

 

Dimension Box: 
(Canvas Toolbar) 
 

 

Displays the length or dimensions of the item being 
drawn. Enter values here to draw items to precise 
measurements. 
 

 
 

 

Function Button: 
(Canvas Toolbar) 
 

 

Enables specific automated features that are available in 
each module. This button starts that automation process. 
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Drawing: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

INTRODUCTION TO DRAWING: 
 
 

Drawing Toolbar: 
 
There are 20 Drawing Tools in this toolbar. These drawing tools are split into the 
following groups: 
 
 

Group 
 

 

Drawing Tools 
 

Manipulation Tools: 
 

Select Tool, Hand Tool, Plus Tool and Crop Tool. 
 

 

Shape Tools: 
 

 

Line Tool, Curve Tool, Square Tool and Oval Tool. 
 

 

Labelling Tools: 
 

 

Arrow Tool, Text Tool, Dimensions Tool and Measure 
Tool. 
 

 

Bathroom Tools: 
 

 

Rail Tool, Shower Tool, Toilet Tool, Door Tool, Bath Tool 
and Vanity Tool 
 

 

Additional Tools: 
 

 

Shower Items Tool, Wall Items Tool 

 
 
Hovering over the tool button will display the name and Shortcut Key for that 
Drawing Tool. 
 
Objects are drawn by clicking and dragging on the canvas. 
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Drawing Tool Categories: 
 
Drawing Tools can also be categorised as Line-Based, Rectangle-Based or Text-
Based. 
 
 

Category 
 

 

Drawing Tools 
 

Line-Based Objects: 
 

Line Tool, Curve Tool, Arrow Tool, Dimension Tool, 
Measure Tool and Rail Tool  
 

 

Rectangle-Based 
Objects: 
 

 

Square Tool, Oval Tool, Shower Tool, Toilet Tool, Door 
Tool, Bath Tool, Vanity Tool, Shower Fittings Tool and 
Wall Fittings Tool. 
 

 

Text-Based Objects: 
 

 

Text Tool and auto-text from Arrow and Dimension Tools. 
 

 
 
 

Shift-Key Effect: 
 
Press SHIFT while drawing a Line-Based item to draw either vertical, horizontal 

or at a 45 angle. 
 
Press SHIFT while drawing a Rectangle-Based item to draw a perfect square (for 
Shape Tools) or to correct proportions (Bathroom Tools) 
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DRAWING PARAMETERS: 
 
 

Project Parameters: 
 
There are a number of project parameters that activate project commands. They 
are visible all the time. These parameters are: 
 

 
 
 

Parameter 
 

 

Description 
 

New: 
 

Creates a new OT Draw project.  

 
 

Open: 
 

 

Opens an existing OT Draw project. 
 

 

Save: 
 

 

Saves the OT Draw project in current location. 
 

 

Print: 
 

 

Opens print dialog box to print current diagram. 

 
 

Cut, Copy & Paste: 
 

 

Used to remove, duplicate and relocate objects. 
 

 

Undo and Redo: 
 

 

Used to undo and redo drawing actions. 

 
 

Standard Drawing Parameters: 
 
There are a number of standard parameters that will apply across most of the 
objects you draw. They are visible all the time. 
 

 
 
 

Parameter 
 

 

Description 
 

Line Width: 
 

Determines the width of the lines in the object. 

 
 

Line Style: 
 

Determines whether the line is solid, dash or 
dot. 

 
 

Line Colour: 
 

 

Determines the colour of the lines in the object. 
 

 

Fill Decider: 
 

 

Determines whether the object is filled in or is 
transparent. Shortcut Key = ‘F’ 
 

 

Fill Colour: 
 

 

If the Fill Decider is set to true then this 
determines the internal or fill colour of the object. 

 
 

Snapping: 
 

 

Determines whether the drawing tool will ‘snap’ 
to the end of the ends and corners of objects in 
the diagram. Shortcut Key = ‘N’ 
 

 

Dbl-click the 
‘Fill’ label to 
reset the tool 
to ‘On’ & the 
colour to white.  
 

Dbl-click the 
‘Line’ label to 
reset the width 
to ‘1pt’, the 
style to ‘Solid’ 
and the colour 
to black.  
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Font Parameters: 
 
These parameters apply to the text based labelling tools ie, the Text, Arrow and 
Dimension Tools. These parameters are visible all the time. 
 

 

 
 

Parameter 
 

 

Description 
 

Font Name: 
 

Determines the type of font that will be used. 

 
 

Font Size: 
 

 

Determines the size of the font that will be used. 
 

 

Bold: 
 

 

Determines whether the font will be Bold. 

 

Italic: 
 

 

Determines whether the font will be Italic.  

 
 

Font Alignment: 
 

 

Determines whether the font will be aligned left, aligned 
right or centred. 

 
 

Auto Insert Text: 
 

 

Determines whether the Arrow and Dimension Tools will 
automatically insert text. The Arrow Tool displays a 
textbox for labelling. The Dimension Tool inserts the 
measurement value along with the dimension line. 
 

 
 
 

Specific Parameters: 
 

 
 
There are a number of specific parameters that will only become visible when a 
certain Drawing Tool has been selected. These parameters include things such 
as the size of the arrowheads, direction of the drawing item or different types of 
the drawing object. All these parameters are outlined in the sections below. 
 
 
 



                   Chapter 2:     Drawing  9 

DRAWING TOOLS: 
 
 

Manipulation Tools: 
 
 

Tool 
 

 

Description 
 

Select Tool: 
[space] 

 

Selects objects to then move, modify, resize, arrange, 
copy and delete them. 
 

 

Hand Tool: 
[H] 
 

 

Moves all the objects in the diagram. Use this tool to pan 
across your diagram. 

 

Crop Tool: 
[ [ ] ] 
 

 

Draws crop boundaries around the diagram. Press 
ENTER to perform crop. 

 

Plus Tool: 
[P] 
 

 

This tool only works in the Bathroom Templates 
Module. Clicking on a wall will add standard fittings such 
as rails and shower fittings to the template. 
 

 
 
 

Shape Tools: 
 
 

Tool 
 

 

Description 
 

Line Tool: 
[L] 
 

 

Draws a straight line by clicking and dragging on the 
canvas.  
Press the ‘L’ key while drawing to draw multiple lines that 
form a Line-Shape (see page 22 for more details). 
 

 

Curve Tool: 
[C] 
 

 

Draws either an arc or a curve. For an Arc draw a line 
and then press the ‘C’ key to draw a smooth arc between 
those points. The Curve option draws a curve shape 
through a series of points. Press the ‘C’ key to add points 
in the curve. 

 
 

Square Tool: 
[S] 
 

 

Draws a rectangle by clicking and dragging on the 
canvas. 

 

Oval Tool: 
[O] 
 

 

Draws an oval by clicking and dragging on the canvas. 
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Label Tools: 
 
 

Tool 
 

 

Description 
 

 

Specific 
Parameters 
 

 

Arrow Tool: 
[A] 
 

 

Draws an arrow by clicking and  
dragging on the diagram. 

 

Arrowhead size 
Direction of arrow 

 

Text Tool: 
[T] 
 

 

Click on the canvas to display the  
textbox. Enter text and then click 
outside the textbox to insert the text 
on the diagram.  
Press ESC to cancel the textbox. 
 

 

Direction of text  * 

 

Dimension Tool: 
[D] 
 

 

Draws a dimension line by clicking 
and dragging. Press the ‘D’ key to slide 
the dimension away from the object. 
 

 

Arrowhead Size 

 

Measure Tool: 
[M] 
 

 

Measure the distance between 2 points 
on the canvas based on the Scale 
Factor. Press the ‘M’ key before 
releasing the mouse to retain the 
measurement line on the diagram. 
 

 

 
 
The text direction can be set to rotate the text to different orientations: 
 

 
 
 

 
 

Bathroom Tools: 
 
 

Tool 
 

 

Description 
 

 

Specific 
Parameters 
 

 

Rail Tool 
(Side View) 
[R] 
 

 

Draws a side rail through a series of 
points. Press the ‘R’ key to add points 
on the rail. Press the TAB key to 
alternate between Rail End Options. 
 

 

Rail View * 
Rail End Options 
 

 

Rail Tool 
(Top and  
Corner View) 
[R] 
 

 

Draws a top-view rail by clicking and 
dragging. Use the Arrow keys to 
change the Rail direction while 
drawing. 

 

Rail View * 
Rail Direction 

 

 

 

 

 

 

* 

Down 
 

L
e
ft 

 

R
ig

h
t 
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Tool 
 

 

Description 
 

 

Specific 
Parameters 
 

 

Shower Tool 
[Alt+S] 

 

Draws a shower recess by clicking 
and dragging. Press the TAB key to 
alternate between Hob Options. 
 

 

Hob Options  

 

Toilet Tool  
[Alt+T] 
 

 

Draws a toilet as you click and drag.  
Press the TAB key to alternate 
between Draw Start Point. Press the 
Arrow keys to change the Toilet 
direction while drawing. 
 

 

Start Point  ** 
Toilet Direction 

 

Door Tool  
[Alt+D] 
 

 

Draws a toilet by clicking and dragging.  
Press the TAB key to alternate 
between Door Swing options. Use 
Arrow keys to change the Toilet 
direction while drawing. 
 

 

Door Swing *** 
Door Direction 
Door Width *** 

 

Bath Tool  
[Alt+B] 
 

 

Draws a bath by clicking and dragging.  
Use the Arrow keys to change the 
Bath Direction while drawing. 
 

 

Bath Direction 

 

Vanity Tool 
[Alt+V] 
 

 

Draws a vanity, wall basin or corner 
basin by clicking and dragging. Use 
the Arrow keys to change the Vanity 
Direction while drawing. 
 

 

Vanity Type **** 
Vanity Direction 

 
 

There are 3 Rail Views: Side View, Top View and Corner View. 
 

The Side View is a curved rectangle to represent a rail placed on a wall. The Rail 
End parameter can be set to Round End or Square End. 
 

The Top View and Corner View are both designed to be used with in the 
Bathroom Floorplan module. They operate like the other Bathroom Drawing Tools  
and have a direction that can be changed. This direction is determined by the 
Rail Direction parameter. 

 
There are 2 options for the Toilet Draw Start Point parameter: Draw From Edge 
and Draw From Middle. The Draw From Middle option is designed to assist with 
drawing the toilet a distance from the wall to the centre of the toilet. 

 
The Door Swing value changes which way the door opens. It can be set to ‘No 
Swing’ for a sliding door. The Door Width value determines the thickness of the 
rectangle section of the door.  

 
There are 4 Vanity Types: Vanity, Wall Basin, Corner Basin and Bench. 
Changing this parameter will change the appearance of the floorplan but will also 
affect the look of the room side view. 
 
 

 

* 

** 

*** 

**** 
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Please note:  

 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Additional Tools: 
 
 

Tool 
 

 

Description 
 

 

Specific 
Parameters 
 

 

Shower Fittings 

[Alt+H] 

 

Draws a shower fitting by clicking 
and dragging. Use the Arrow keys to 
change the Fitting direction while 
drawing. 
 

 

Fitting Type * 
Direction of Item 

 

Wall Fittings 
[Alt+W] 
 

 

Draws a cabinet, mirror or window by 
clicking and dragging. 
 

 

Fitting Type ** 

 
 
There are 5 Shower Fittings Options: Hand Shower, Shower Peg, Fixed Rose, 
Tap and Lever Tap. Use these objects to add to bathroom templates and 
bathroom side views. 

 
There are 3 Wall Fittings Options: Cabinet, Mirror and Window. 
Use these items to add to bathroom side views. 

 
 
 

 
 

* 

** 

 

 

When drawing a bath, vanity, wall basin or corner basin they 
are initially drawn with taps and a nozzle. However by 
selecting and right clicking the object you can hide the taps or 
nozzle. Right-click again to re-show the feature. 
 
When you create a side-view (see Page 50) the corresponding 
object will also be displayed with taps or nozzle hidden. 
 
When a side-view of a vanity has been created, it is initially 
drawn with cupboard doors. These can also be removed by 
selecting the vanity and right-clicking. 
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DRAWING TO SCALE: 
 
 

Scale Factor: 
 
The Scale Factor textbox displays the current drawing scale. The default scale is 
1:20. The Scale Factor changes to a percentage value for the Bathroom 
Templates and Picture Design modules as these are not drawn to scale. It is 
possible to set the relative scale for Picture Designs as outlined below. 
 
 

Please note:  
 
 
 
 

Reading the dimension as you draw: 
 
The Dimension Box in the bottom right corner displays the length or dimensions 
of the object in millimetres. The length is displayed as a single value for any line-
based object.  The horizontal and vertical dimensions are displayed as two 
values separated by a comma for any rectangle-based object. 
 

  
 
 

Entering the dimension as you draw: 
 
Exact dimensions of an object can be entered whilst drawing. For line-based 
objects simply enter the value of the length and press ENTER. The object will 
appear in the same direction at the length you determined. 
 
This is also applicable for rectangular objects. While the object is being drawn 
enter the horizontal value, a comma, the vertical value and then press enter. It 
will then draw the object in the same direction with the dimensions you 
determined. 
 
 
 

Dimensions while selecting: 
 
When an object is selected and resized the new dimensions will be displayed in 
the Dimensions Box. However, it is not possible to enter values to set the length 
or dimensions while resizing. When a selected object is being moved the 
Dimension Box will show how far the objects have moved from their original 
location. 
 
 
 

 

The diagram is set to the right scale on the computer screen. 
However when you export or print the image, the image size 
needs to be 100% to remain at that scale. 
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Setting the Relative Scale for Picture Designs: 
 
See ‘Module: Picture Designs’ section for more information on using this 
feature. This module allows the insertion of a picture or photo to draw on. This 
means that the scale for this picture is meaningless because it is impossible to 
know the size of whatever is in the picture. 
 
However it is possible to set a relative scale for the picture. Start by selecting the 
Measure Tool and measuring something in the picture that has a precise 
measurement (eg: the height of a step). Enter this value in the Dimension Box 
and press enter. The scale is now set to this ratio. 
 
 
Please note:  
 
 
 
 

This is not an exact scale as the picture will have varying 
depths which affects the true scale of that part of the picture. 
However it will make the scale more comparable. 
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Modifying Objects: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SELECTING OBJECTS: 
 
 
Selecting is the ability to highlight an object or several objects in order to move, 
change or edit them. Selecting an object changes its colour to red and creates 
markers in order to move and resize it. 
 
 

How to Select: 
 
Select and deselect in the following ways: 
 
 

Method 
 

 

Description 
 

Click to Select: 

 

Click the Select Tool and then click the object. It will 
select the top most object. Press the SHIFT button while 
selecting items to select more than one object. Deselect 
objects by clicking them again. 
 

 

Select Box: 
 

 

Click and drag a select box around the objects you wish 
to select. An object will only be selected if the whole 
object is within the select box. This option is only active 
when no objects are currently selected. 
 

 

Select All: 
 
 

 

Select all the objects on your canvas by using the Select 
All command in the Edit menu. Ctrl-A will perform the 
same function. 
 

 

Deselect:  
 

 

Pressing the ESC key will deselect all objects. 

 
 

 
 

3 



16                 Chapter 3:     Modifying Objects 

Operations that may be performed on selected objects: 
 
 

No of Objects 
 

 

Operations 
 

 

Functions 
 

 

1 Object Selected: 
 

Features: 
 

 

Change Parameters 
 

  

Manipulate: 
 

 

Move 
Resize 
Rotate 
Delete 
 

  

Duplicate: 

 

 

Cut 
Copy 
Paste 
 

  

Arrange: 

 

 

Bring to Front 
Bring Forwards 
Send to Back 
Send Backwards 
 

  

Text: 

 

 

Edit Text 
 

 

2 or More Objects Selected: 
 

 

Features: 

 

Change Parameters 

  

Manipulate: 

 

 

Move 
Delete 
 

  

Duplicate: 

 

 

Cut 
Copy 
Paste 
 

 
 
 

CHANGING OBJECT PARAMETERS: 
 
 
If an object is selected, its current parameters will be shown in the parameter bar. 
 
When any object (Line, Rectangle or Text Based) is selected, change its features 
simply by changing the parameters. For instance, if a Line object is selected, 
change the width from 1px to 5px by changing the Line-Width parameter. 
 
In the same way, change an object’s line colour and fill colour, as well as change 
the text font, size and style.  
 
Adjust the specific parameters of an object to change its appearance. For 
instance, change the size of the arrowhead for dimensions and change the 
direction of toilets and other bathroom objects. 
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MANIPULATING OBJECTS: 
 
 
After selecting objects it is then possible to move and manipulate them within 
your diagram.  
 
 

Moving Objects: 
 
To move a selected object, hover over the centre of the object until the cursor 
becomes a 4 point arrow. Then click and drag to move the object. The movement 
away from the original point will be shown in the Dimension Box.  
 
SHIFT key: 
 
 

 
 

Resizing Objects: 
 
To resize the object click and drag the markers at the end of the line-based object 
or at the corners of the rectangle-based object.  
 
SHIFT Key: 
 
 
 
 
 
 

 
 
 

Press the SHIFT key while moving the object to move in a 
horizontal or vertical plane. 

Pressing the SHIFT key while resizing will result in the 
following: 
 

Line-based object:  The line retains in the same direction. 
 

Rectangle-based object:  The rectangle retains the same 
horizontal and vertical proportions. 
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Rotating Objects: 
 
To rotate an object, click and drag on the green circle. The object will rotate as 
the cursor is moved around the object. 
 
SHIFT key: 
 
 

 
 
 
 

Deleting Objects: 
 
While objects are selected, delete them in the following ways: 

1. Press the Delete or Backspace keys 
2. Right-click the canvas to bring up the context-menu and select the Delete 

option. 
 

 
 
 

 

Pressing the SHIFT key while rotating the object will make it 

snap to 45 angles. 
. 
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DUPLICATING OBJECTS: 
 
 
Duplicate objects by using the Cut, Copy and Paste commands. These can be 
accessed in 3 ways: 

1. Click the Cut, Copy and Paste buttons in the Parameter Bar 
2. Select them in the Edit Menu 
3. Use the shortcut keys of Ctrl+X (Cut), Ctrl+C (Copy) and Ctrl+V (Paste) 

 

 
 
 
Cutting or copying an object allows it to be pasted elsewhere in the project, 
including in different canvases and modules. When the object is pasted, it is 
placed directly over the original. Move the object if it is required in a different 
location. 
 
 
 

ARRANGING OBJECTS: 
 

 
Arrangement Commands: 
 
All the objects are layered depending on when they were drawn. When a new 
object is added it is drawn on top of the layers. Rearrange these layers to change 
the layout using the following commands: 
 
 
 

Command 
 

 

Description 
 

Bring to Front: 

 

Brings the object in front of all other objects. 
 

 

Send to Back: 
 

 

Sends the object behind all other objects. 
 

 

Bring Forward: 
 

 

Brings the object up one layer. 
 

 

Send Backward:  
 

 

Sends the object down one layer. 
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Rearranging Diagram Layers: 
 
Access these arrangement commands by right-clicking the canvas when a single 
object is selected. Then select the required option from the context menu. 
 
      
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 
 

2 
 

3 
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EDITING TEXT: 
 
 

Change the words in a text object at any time by using the Edit Text command. 
Make sure the text object is selected, then right-click the canvas and select the 
Edit Text command. 
 
This will reshow the textbox to change the text value. Click outside the textbox to 
insert your new text or press ESC to cancel and retain the existing text. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Please note:  
 
 
 

CREATING LINE-SHAPES: 
 
 

A line-shape is an object made of connected lines. It can have up to 12 sides and 
can have a fill-colour. There are 2 ways to create a line-shape: 
 
1. While drawing with the Line Tool, press the ‘L’ key to 

create junction points in the line-shape. When the mouse 
is released a single object is created. 

 
2. Select a series of connected lines and select the ‘Create 

Lineshape’ command in the Format menu. This command 
is only visible when a collection of lines is selected.  

 
 
Please note:  
 

1 
 

2 
 

3 
 

Use the ‘Select All Text’ command in the Format menu to 
select all the text in the canvas at once. 

A line-shape can be broken down into separate lines by 
selecting the ‘Separate Lineshape’ in the Format menu. 
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MODIFYING JUNCTION POINTS: 
 
 

There are 3 objects that contain junction points: Line-Shapes, Curves and Rails. 
When these objects are selected it is possible to add or remove junction points. 
 
These commands are accessed by selecting an object with junction points and 
right-clicking the mouse. The following context-menu is displayed: 

 
 

 
 
 

Add Junction Point: 
 
When the object is selected, add an additional junction point by right-clicking and 
selecting the appropriate command. 
 
Select either Add New End Point to add a junction point to the end of the object 
or Add New Junction Point to add a point to the middle. 
 
The additional junction point is added to the object at the location where the 
mouse was clicked. 
 
 
 

Remove Junction Point: 
 
To remove a junction point, right-click the object and select the Remove Junction 
Point command. 
 
The junction point nearest to the click point is removed.
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Modifying the Canvas 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

UNDO AND REDO: 
 
 
Undo and redo are powerful operations for modifying your diagram. Each canvas 
has its own undo and redo operations, allowing undo and redo options to occur 
between canvases. 
 

 
 
Operate the undo and redo commands in the following ways: 

- Use the buttons in the Parameter Bar 
- Select the options in the Edit menu 
- Use the shortcuts Ctrl+Z (undo) and Ctrl+Y (redo) 

 
 
 

ZOOMING AND PANNING: 
 
 

Zooming: 
 
Zoom and Pan change the view of the diagram. These features are built into 
other features. 
 
To zoom in and out of the diagram simply change the Scale Factor for that 
canvas. This can be done in 2 ways: 

1. Click on the Scale Factor dropdown button and select the new Scale 
Factor. The smaller the number the larger the diagram will become. 

2. Under the Tools Menu select either the Zoom-In or Zoom-Out options. 
 

 
 

4 
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Zooming Example: 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

 
 

Panning: 
 
Panning is the ability to move the diagram around on the page. Do this by using 
the Hand Tool. Simply click and drag to move the diagram to a new location. The 
amount that the diagram has been moved can be seen in the Dimension Box. 
 
 

 

1 
 

2 
 

3 
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CROPPING AND RESIZING THE CANVAS: 
 
 

Crop the Canvas: 
 
After drawing a diagram it is good practice to crop the image as it helps decrease 
the amount of white space in your image. 
 
To crop an image select the Crop Tool and draw the boundary lines around the 
diagram. Adjust these boundary lines to the exact spot you wish to crop. Then 
while the boundary lines are showing press ENTER to crop the diagram. To 
cancel the boundary lines press ESC and they will disappear. 
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Resize The Canvas: 
 
Using the Crop Tool can only make the image smaller. However, it is possible to 
also make the image bigger. To do this, select the Set Canvas Size command in 
the Format menu. 
 
You are offered 2 ways to resize the image: 

1. Set the exact pixel size of the image 
2. Set the new size as a percentage of the existing size 

 
Locking the ratio will constrain the height and width proportions. 
 

 
 
 
Using this feature allows the image to be smaller or larger than the existing one. 
When making it larger the canvas will create scrollbars in order to see the whole 
image. 
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Reset the Canvas: 
 
To return the diagram to the full size of the canvas you must reset the canvas. 
Access the Reset Canvas command in the following ways: 

1. Go to the Format menu and select Reset Canvas 
2. Press the Edit Canvas button in the Canvas Toolbar and select Reset 

Canvas. 
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Formatting 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

CREATING AN OT DRAW PROJECT: 
 
 
The canvas is the drawing section of OT Draw. However, it is possible to have 
multiple canvases so that different OT diagrams can be created for the same 
client. The collection of these diagrams is called an OT Draw Project. 
 

 
 
 
 

Creating a Project: 
 
When OT Draw is first opened a new empty Project called ‘Untitled’ is created. 
If a Project is already open, start a new Project by: 

- Clicking the New parameter  
- Going to File  New 
- Using the shortcut Ctrl+N 

 
 

Saving a Project: 
 
An OT Draw project is able to be saved so that additional diagrams or changes to 
existing diagrams can be made at a future date. A project is saved by: 

- Clicking the Save parameter 
- Going to File  Save Project 
- Using the shortcut Ctrl+S 

 
If the project hasn’t previously been saved then a dialog box will appear asking 
for a project name and location to be entered. If the project has previously been 
saved then it will simply be re-saved in that same location. 
 

5 
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The project can be saved under a new name by using the Save Project As 
command in the File menu. This option might be used to create different projects 
for different stages in the home modification application. 
 
 

 
 
 
 
 
Opening a Project: 
 
An existing project can be opened to make additions or amendments. OT Draw 
Projects are saved with a file extension of .otd (eg: MyProject.otd). This .otd file 
can be opened by: 

- Clicking on the Open parameter 
- Going to File  Open 
- Using the shortcut Ctrl+O 

 
A project can also be opened by double-clicking the project icon in the location 
where it is saved. This will automatically open OT Draw along with this project. 
 
 
 

WORKING WITH CANVASES: 
 
 
An OT Draw Project can have multiple canvases reflecting the multiple diagrams 
saved in the project. Each canvas it represented by a Tab at the bottom of the 
canvas. The canvas name is identified by the Tab label.  
 
The Canvas Toolbar has commands to edit and format the canvases. The canvas 
can be edited by selecting the Clear Canvas or Reset commands. Canvases can 
also be formatted by adding, deleting and renaming. 
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Clearing the Canvas: 
 
At any point clicking the Clear Canvas button will clear the current canvas. This 
will wipe the canvas clean to start a new diagram. 
 
 

Resetting the Canvas: 
 
Resetting the canvas restores the original size of the canvas. As previously 
mentioned the canvas can be cropped or resized to suit the diagram. To reverse 
that action, reset the canvas so that it fills the entire space again. 
 
Resetting the canvas after a bathroom template or picture is inserted will do 2 
things: 

- Show the entire image again if it has been cropped 
- Reset the scale back to 100% 

 
To clear the canvas, select Clear Canvas in the Edit Canvas menu. 
 
 

Adding and Deleting Canvases: 
 
Modify the project by adding and deleting canvases to create and remove 
diagrams. 
 
The Add Canvas and Delete Canvas commands are in the Edit Canvas menu at 
the bottom on the screen. 
 
When the Delete Canvas command is selected a confirmation box will appear. 
Select ‘Yes’ to delete your canvas. 
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Renaming Canvases: 
 
Rename the different canvases to identify the types of diagrams being created. 
Appropriately naming the canvases will assist when exporting or transferring 
multiple images. 
 
To rename the canvas select the Rename Canvas option in the Edit Canvas 
menu. A pop-up menu and textbox will appear. Enter the new name for the 
canvas and click ok. Press ESC to exit this menu. 
 

 
 
 
Please note:  
 
 

 
 
 
Duplicating Canvases: 
 
Using the Cut, Copy and Paste tools will duplicate objects but it is also possible 
to duplicate an entire canvas. Duplicating a canvas will create an exact replica of 
the existing canvas including all objects and scale settings. This is convenient 
when wanting to make two or more diagrams for the same recommendation. For 
example when drawing existing and proposed bathroom floorplans or providing 
different rail options for a stair diagram. 
 
To duplicate a canvas you simply select the Duplicate Canvas option in the 
Format menu and a replica of the current canvas will be created. 
 

 
 
 
 

Canvas names must be unique. You cannot have the same 
name for 2 different canvases anywhere in your project. If you 
enter an existing name you will be asked to enter a different 
name. 
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WORKING WITH MODULES: 
 
 

What are Modules? 
 
As well as having multiple canvases, an OT Draw Project has multiple modules. 
A module is a specific type of OT diagram. In OT Draw there are 6 different 
modules: 
 

 

 
 
 
 
Within each module OT Draw has certain functions that assist with drawing these 
types of diagrams. See the Modules section in the manual for a full description of 
how these functions work. 
 
Each module can have multiple canvases to create several similar types of 
diagrams. For instance, the Stair Design module can have two canvases, one for 
the Front Stairs diagram and one for a Back Stairs diagram. 
 
Move between the different modules by clicking on the six different modules in 
the Module bar on the left of the canvas. 
 
 
 

 

Blank Canvases 

Stair Designs 

Bathroom Floorplans 

Ramp Designs 

Insert Pictures 

Bathroom Templates 



34                 Chapter 5:     Formatting 

The Function Button: 
 
The real power of OT Draw is its ability to assist with drawing specific types of OT 
diagrams. Within each module there is a specific Function Action that assists with 
drawing that type of diagram.  
 

 
 
 
To utilise this Action in a module simply click the Function button in the Canvas 
bar. 
This Function button changes for each of the different modules. The Function 
Actions are outlined below: 
 
 

Module 
 

 

Function Name 
 

Function Action 

 

Blank 
Canvas 

 

[empty] 
 

 

No action. This is a free drawing module 
to draw any type of diagram. 
 

 

Bathroom 
Template 
 

 

Insert Template  

 

Opens up a form of bathroom template 
options to insert into the diagram. 
 

 

Bathroom 
Floorplans 
 

 

Insert Room /  
Create Side Views 

 

Opens up a form to specify the shape 
and size room to insert. Then based on 
your floorplan will create side views of 
the selected walls. 
 

 

Stair 
Designs  

 

Design Stairs  

 

Opens up a form to enter values for the 
number and size of steps and rails to 
draw on the canvas. 
 

 

Ramp 
Designs 

 

 

Design Ramp 

 

Opens up a form to enter values for the 
type and size of ramp, platforms and rails 
to draw on the canvas. 
 

 

Picture 
Designs 
 

 

Insert Picture 

 

Opens up dialog box to select a picture to 
insert on the canvas. 
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Exporting Your Diagrams: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
After creating diagrams in OT Draw there are 3 ways to utilise them: 

1. Export Picture – export the diagram as an image to use in documents or 
reports 

2. Transfer to Document – automatically send the diagram to a document 
with client details included 

3. Print Diagram – print the diagram straight from OT Draw 
 
 
 

EXPORT PICTURE: 
 
 

Exporting: 
 
Export the diagram from OT Draw as an image file to use elsewhere. The image 
will contain everything in the canvas. It is good practice to crop the image before 
exporting so that your image is only as big as the diagram. 
 
To export an image: 
1. Select the ‘Export Picture…’ 

option from the File menu. 
2. Choose a filename for the image. 

The default filename is the name 
of your canvas. 

3. Select the type of image. The 
options are JPEG, GIF and BMP. 

4. Select a location to save the 
image file. 

5. Click Save. 
 

 
 
 

6 
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Exporting Multiple Pictures: 
 
If the project contains multiple diagrams it is possible to export all the images at 
once. To export multiple images perform the following steps: 

1. Select the ‘Export All Pictures…’ option from the File menu. 
2. Select the location to store the images files and click ok. 
3. Select the type of image you want to export. 
4. Determine whether to store the images in a new folder and enter a folder 

name. 
5. Click Export All. 

 

 
 

 
Please note:  
 
 
 
 
 
 
 
 
 
 
 
 

 

It is not possible to name each of your image files. The name 
of each file will be the same as its canvas name. Make sure 
the canvases are named appropriately before exporting. 
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TRANSFER TO DOCUMENT: 
 
 

Transferring: 
 
Another way to export diagrams is to transfer them to a document. This action will 
create an image file and automatically insert it into a document. You can also 
insert the client details along with the image. 
 
To transfer diagrams to a document perform the following steps: 

1. Select the ‘Transfer to Document’ option from the File menu. 
2. Decide on the client information to include with the image. 
3. Deselect the checkbox to left of the information type to exclude it. 
4. Click Transfer. 
5. Select name and location for document and click Save. 

 

 
 
Please note:  
 
 

 
 

When an image is inserted into the document it may be 
resized to fit on the page. This means the diagram will be in 
proportion but may not be to the scale that was set. 
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Client Information: 
 
The following categories are available for inclusion in the document: 
 
 

Client Name 
 

Name of client. 
 

 

Client Address 
 

 

Address of client. 
 

 

Client Phone 
 

 

Contact details for client. 
 

 

Works 

 

A description of the recommended modifications. 
 

 

Diagram 

 

A name for the diagram. The default diagram name is the 
canvas name. 
 

 

Therapist Name 
 

 

The therapist recommending the modifications. 
 

 

Date 

 

 

The date of the report. The default is the current date. 

 
 

Transfer All to Document: 
 
As with exporting pictures, it is possible transfer all the diagrams to documents at 
once. 
 
To transfer multiple diagrams perform the following steps: 

1. Select the ‘Transfer All to Document’ option in the File menu. 
2. Decide on the client information to include with the image. 
3. Use the checkboxes beside each information type to determine whether it 

is included with the document. 
4. Click Transfer. 
5. Select a location for the documents and click OK. 
6. Decide whether to store the documents in a new folder, enter a folder 

name and click Transfer All. 

 
Please note:  
 
 
 
 
 
 
 
 
 
 
 
 

The client details, date and therapist name will be the same on 
each document. 

It is not possible to name each of the diagrams in the 
documents. The diagram name will be the same as its canvas 
name. Make sure the canvases are named appropriately 
before transferring. 

It is not possible to enter a description for the works, as this 
will be different for each diagram. If this option is checked it 
will simply provide a title for this section. The description of 
works can be entered via the document itself. 
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Transfer Settings: 
 
There are a number of options to customise the transfer. These transfer settings 
can be accessed from the Format Menu or from the client information page in the 
Transfer to Document option. 
 
Customise using the following settings: 
 
 

Template 
 

Enables the use of a document template as a base for the 
transferred documents. Use this option to create a specific 
template for your department. To select this option check the 
Template option and then click Browse to find and select the 
template. The template must be a .dot file. 
 

 

Transfer All 
 

 

Under the Transfer All option individual documents can be 
created for each diagram or one combined document can be 
created with each diagram inserted on a new page. Select 
either the ‘Multiple Documents’ or ‘Combined’ options. 
 

 

Therapists 
 

 

As Therapist names are entered in the client information 
form, OT Draw will remember these names so you can easily 
use them again. In Transfer Settings view and adjust what 
the current therapist names are. 
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PRINTING YOUR DIAGRAMS: 
 
 
There is an option to print diagrams straight from OT Draw. Before printing note 
the following: 
 
Please note:  
 

 
 
 
 

 
 
 
 
 
Perform the following steps to print a diagram in OT Draw: 
 

1. Determine the appropriate page orientation and change this setting in the 
Page Setup option in the File menu. 

 

 
 
2. Preview the diagram using the Print Preview option in the File menu. This 

will display how the diagram is adjusted to fit on the page. Preview the 
diagram to determine if any setup changes need to be made. Only one 
diagram can be viewed at a time.  

3. Print the diagram by clicking the Print button in Print Preview, or in the File 
menu or in the Parameter Bar. Select the number of copies and the printer 
name then click Print. 

4. Print multiple diagrams at once by using the Print All option in the File 
menu. This will automatically print all the diagrams in the project. This will 
use the same page orientation for all the diagrams. 

 
 
 

The Print option will automatically print the diagram based on 
the current Page Setup orientation (ie: Portrait or Landscape). 

The Print option automatically adjusts the diagram so that it 
fits within the margins of the page. This means the diagram 
will be in proportion but may not be to the scale that was set. 
Cropping the image and selecting the appropriate page 
orientation will assist with fitting the diagram on the page. 
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Modules 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This section will go through each module and how to effectively use the Function 
Button and Drawing Tools to create complex diagrams in minutes. 
 
There are 6 modules in OT Draw: 

 

 
 
 
 

7 

Blank Canvases 

Stair Designs 

Bathroom Floorplans 

Ramp Designs 

Insert Pictures 

Bathroom Templates 
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MODULE:  BATHROOM TEMPLATES: 
 
 
For this module there are two phases for creating the diagram: 

1. Inserting a Template 
2. Adding Rails and Fittings 

 
 

Phase 1: Inserting a Template: 
 

To begin click the Function Button to insert a bathroom 
template onto the canvas. If there are objects already on the 
canvas it will ask if you want to clear them. If there is already 
a bathroom template inserted it will automatically make a 
new canvas. 
 

 
 
 

Choose from a Shower, Bath or Toilet template. 
 

 
    

 
Choose a sub-type for the template that was selected. 
For Shower Templates choose either a Standard Shower or 
Cut-Out Shower and whether it does or doesn’t have a hob.  
 

For Bath and Toilet Templates select the correct orientation 
of the template. 
 

 

 

STEP 1 

 

STEP 2 

 

STEP 3 
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Enter the dimensions for the template. This is optional and 
may be left blank. This will mean that no dimensions are 
drawn on the template. 
 

 

Enter the width and depth 
of the Shower template. 
 
Enter the width, depth and  
height of the Bath template. 
  
The Toilet template doesn’t 
have this step. 
 

 
 
 

Click OK to insert the Template onto the canvas. 
 

 
 
Phase 2: Adding Rails and Fittings: 
 
 

Select the Plus Tool in the Drawing 
Toolbar to the right of the canvas. 
 

 
 
 

Click on one of the template walls. 
 

 

 

STEP 4 

 

STEP 5 

 

STEP 1 

 

STEP 2 
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A form with a number of fittings will be displayed. These 
fittings include: 

 
 

Shower: 
 

 

Bath: 
 

Toilet: 
 

Fixed Shower 
Hand Shower 
Peg for Hose 
Taps 
Horizontal Rail 
Vertical Rail 
 

 

Fixed Shower 
Hand Shower 
Peg for Hose 
Taps 
Horizontal Rail 
Vertical Rail 

 

Horizontal Rail 
Vertical Rail 
Oblique Rail 
‘L’ Shape Rail 

  
Click on the desired rails and fittings and click OK. 
 

 
 
 
 

Enter values for the placement of these rails and fittings. The 
Fixed Shower, Hand Shower and Taps will all automatically 
be place on the wall at a standard position. 

 

All the rails and the peg will require values for the placement 
on the wall. Enter the values and click OK for each one.  

 

For the oblique and ‘L’ Shape Rail options on the Toilet 
template, there are 3 methods for how to insert the values. 
Values can be entered based on both end points or based on 
one end point and an angle. Scroll through the different 
methods by clicking the arrows on the left of the form. 
 

 
 

 

STEP 3 

 

STEP 4 
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Use the Select Tool from the Drawing Toolbar and move or 
delete any objects on the diagram. 

 

 
 
 
 

Repeat above steps for additional walls on the template that 
requires rails or fittings. 

 
 
 
 

 

STEP 5 

 

STEP 6 
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MODULE:  BATHROOM FLOORPLANS: 
 
 
For this module there are 4 phases for creating the diagram: 

1. Inserting a Room 
2. Draw Bathroom Items 
3. Draw Dimensions 
4. Creating Side Views 

 
 

Phase 1: Inserting and Filling a Room: 
 
It is important to insert a room via this method and not by just drawing a rectangle 
as certain drawing tools and side views will not be able to be utilised. 
 
 

To begin click the Function Button to insert a room for the 
bathroom floorplan.  
 

 
 

 
 

Select either a Rectangular, L-Shape or T-Shape room. This 
should cover any type of bathroom shape. 

 

 
 
 
 

 

 

STEP 1 

 

STEP 2 
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Select the direction or orientation of the room. This step is only 
applicable for L-Shape and T-Shape designs. 
 
 

 
 
 

 
Enter the values for the room. For a rectangular shape room 
simply enter the width and length of the room. For L-Shape and 
T-Shape rooms enter the width and length and then adjust the 
measurements of the jut-out section of the room. Click OK to 
insert the room onto the canvas. 
 

 

 
 
 

 

 

STEP 3 

 

STEP 4 
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Phase 2: Draw Bathroom Items: 
 
Once the room has been inserted it’s time to start drawing the different bathroom 
objects. 
 
Select one of the following Drawing Tools to add bathroom objects to the 
floorplan. Each tool is selected by clicking on the Toolbar button or using its 
corresponding shortcut. Some tools have different types that you can select from. 
 
 

Tool 
 

 

Description 
 

 

Specific 
Parameters 
 

 

Rail Tool 
 
 

 

Draw a top-view rail by clicking and 
dragging. Press the Arrow keys to 
change the Rail direction while 
drawing. 
 

 
Rail Direction 
Rail Types: 
- Top View 
- Corner View 
 

 

Shower Tool 
[Alt+S] 

 

Draw a shower by clicking and 
dragging. Press the TAB key to 
alternate between Hob Options.  
 

 

Hob Options  

 

Toilet Tool  
[Alt+T] 
 

 

Draw a toilet by clicking and dragging.  
Press the TAB key to alternate 
between Draw Start Point. Press the 
Arrow keys to change the Toilet 
direction while drawing. 
 

 

Draw from Edge 
or from Mid. 
Toilet Direction 

 

Door Tool  
[Alt+D] 
 

 

Draw a door by clicking and dragging.  
Press the TAB key to alternate 
between Door Swing. Press the 
Arrow keys to change the Door 
direction while drawing. 
 

 

Door Swing 
Door Direction 
Door Width 

 

Bath Tool  
[Alt+B] 
 

 

Draw a bath by clicking and dragging. 
Press the Arrow keys to change the 
Bath Direction while drawing. 
 

 

Bath Direction 

 

Vanity Tool 
[Alt+V] 
 

 

Draw a vanity, wall basin or corner 
basin by clicking and dragging. Press 
the Arrow keys to change the Vanity 
Direction while drawing. 
 

 

Vanity Direction 
Vanity Types: 
- Vanity 
- Wall Basin 
- Corner Basin 
- Bench 
 

 
Drawing these bathroom objects to scale will ensure the floorplan is accurate and 
the layout fits in the space. See the Drawing section on page 12 for more 
information about drawing to scale. 
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Drawing Techniques for Bathroom Objects: 
 
 
 Normally when snapping is turned on it means the cursor will 

snap to the end-points and corners of objects in the canvas. 
However, when a floorplan room is inserted it will snap with a 
blue dot in the corners but will also snap with a purple dot along 
the walls. This helps with drawing items flush against the wall. 
When the cursor is snapped along a wall the dimension box will 
display the relative distances. For instance if the wall is 
2500mm wide and the cursor is at the point 800mm from the 
left, the dimension box will read [800, 1700] meaning it is 
800mm from left and 1700mm from the right. This feature will 
help you position the objects accurately. 

 
 
 
 Nearly every bathroom object has a direction parameter that 

represents which way it will face on the diagram. Either set this 
parameter before starting to draw or press an arrow key while 
drawing to make the object change its direction. 

 
 
 

There are a few parameters that have 2 options and can be 
changed with the TAB key. These include: 
 
Shower Object:   Hob / Hobless 
Toilet Object:      Draw from Edge / Draw from Mid 
Door Object:        Door Swing Direction 
 

Either set this option before starting to draw or press the TAB 
key while drawing to adjust the object. 

 
 
 

There is a specific option for drawing the toilet either from the 
edge or from the middle. Drawing from the middle helps when 
making the toilet a certain distance from the wall to the midline. 
For instance to make the toilet 450mm from the wall, snap the 
cursor along the appropriate wall, find the distance 450mm from 
edge using the dimension box values, then draw the toilet using 
the Draw From Mid parameter. 

 
 
 

 
 
 
 
 
 

 

Snapping 

 

Direction 

 

Tab Key 

 

Toilet 
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Phase 3: Draw Dimensions: 
 
After adding all the relevant bathroom items to your floorplan add dimensions to 
the diagram. The best way to use dimensions for bathroom floorplans is to use 
the slide feature in the Dimension Tool. Use the following steps: 
 

Click on the Dimension tool in the Drawing Toolbar or press ‘D’ 
to select it. 

 
 

Draw the dimension by snapping between corner points of the 
room or bathroom object. 

 
 

Before letting go of the mouse button, press ‘D’ again to slide 
the dimension away from the object to create dimensions 
around the border of the room. 

 
 
 

Phase 4: Create Side views 
 
Once the floorplan has been completed you are able to use the powerful Create 
Side Views function in OT Draw. Simply perform the following steps: 
 
 

Click the Function Button which has now changed to Create 
Side Views 
 

 
 
 

Create a side view by clicking the checkbox associated with that 
wall. Create multiple side views by clicking multiple checkboxes. 
 

 
 
 

 

STEP 1 

 

STEP 2 

 

STEP 3 

 

STEP 1 

 

STEP 2 
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Click OK to create your views. Additional canvas tabs will be 
created for your side views and will be named accordingly. Click 
on these tabs to access and edit these side views. 

 
 

The program will automatically create side views of the 
bathroom objects in the floorplan. The height of these items can 
be altered by clicking on the item and dragging the height 
marker up and down. 
 

 
 
 
 

Add additional objects and fittings to the side view. Use the Rail, 
Arrow and Dimension drawing tools to draw and label rail 
locations. Use the Shower Fittings (Alt+H) drawing tool to add 
shower heads, taps and shower pegs to the diagram. Use the 
Wall Fittings (Alt+W) drawing tool to add windows, mirrors and 
cabinets to the diagram. 

 
 
 

 
 
 
 
 

 

STEP 3 

 

STEP 4 

 

STEP 5 
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MODULE:  STAIR DESIGNS 
 
 

Click the Function button to start Stair Design process. This will 
bring up a design form that will set the preferences for different 
features of the stair diagram. There are 7 steps to complete. 
 

 
 
 

Perspective: 
 

Determine whether diagram will have either a left or right 
perspective. Click on the image to select the perspective.  
Click Next to continue 
 

 
 
 

Display Features: 
 

Decide on the following key features of the diagram: 
 

No. of steps:   Enter the number of steps required in the 
diagram. This number is determined by the 
number of stair rises. 

 

Lateral Lines:  This feature can be set to either Yes or No. 
Entering Yes will draw additional lines at the 
sides of the steps to provide extra 
perspective, making it look like there is a wall 
along that side. 

 

Draw Labels:  This feature can be set to either Yes or No. 
Entering Yes will draw the steps and all rise 
and tread dimensions. Entering No will draw 
the stairs without any rise and tread 
dimensions. 

 

 
 

 

START 

 

STEP 1 

 

STEP 2 



                   Chapter 7:     Modules  53 

Display Features: (continued) 
 
Stair Values: This feature has 3 options for how to enter 

values for the rise and tread of the stairs. 
You have the following options: 

 
 

Enter Each Value 
 

Enter the rise and tread of every stair 
value. 

 
 

Enter Total Lengths 
 

 

Enter the total rise and tread for the set 
of stairs. 
 

 

Standard Size Steps
  

 

Enter no values. The program will draw 
standard size rise and tread for the 
steps. 
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Stair Values: 
 

Enter the values of the rise and tread of the stairs. Based on the 
features set in Step 2 enter the values for each step or the total 
rise and height. 
If the Stair Values setting in Step 2 was set to ‘Standard Size 
Steps’ then this step will be skipped. 

 
 
 

Rail Options: 
 

Select what type of rail, if any, is required on the diagram. 
Select a far side rail, a near side rail, bilateral rails or no rails at 
all. Click on a rail image to select it. Click an image again to 
deselect. Make your selection and click Next to continue. 
 

 
 

 

 

STEP 3 

 

STEP 4 
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Far Rail Values: 
 

If a far-side rail was selected in step 4 then enter the 
appropriate values for this rail. If a far-side rail wasn’t selected 
then this step will be skipped. Values to be entered include: 
 

 
 

 
 

Value 
 

 

Description 
 

 

Special Features 
 

 

Bottom Lead-In 
 

A horizontal lead-in at the 
bottom of the steps. 
 

 

Can be left blank. 
Value must be a positive number. 
 

 

Bottom Tread 

 

How far the angled rail 
extends past the bottom 
step. 
 

 

Can be left blank. 
Value can be negative if rail is to 
finish before bottom step. 
 

 

Top Lead-In  

 

A horizontal lead-in at the 
top of the steps. 

 

Can be left blank. 
Value must be a positive number. 
 

 

Top Tread 

 

How far the angled rail 
extends past the top step. 

 

Can be left blank. 
Value can be negative if rail is to 
finish before top step. 
 

 

Rail Height 

 

The height of the rail from 
top of the steps. 
 

 

Must have a value. 
Value must be a positive number. 

 
 

 

STEP 5 
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Select from the following options to determine the labels to be drawn with the rail: 
 

 

Label 
 

 

Description 
 

 

Draw all labels 
 

Draws labels and dimensions for Rail height as well as 
tread and lead-in values. 

 
 

Draw Height Label 
 

 

Only draws the label and dimension for the rail height. 

 

Draw No Labels  

 

Only draws the rail without any additional labels or 
dimensions. 
 

 
 

Near Side Values: 
 

This step is the same as Step 5 but for the near side rail. Enter 
the values for lead-in, tread and rail height for this rail. Select 
what labels you want drawn with the rail. 
 

If a near-side rail wasn’t selected then this step will be skipped. 
If values were entered for a far-side rail in step 5 then these 
values will be carried over. Edit these to have different values if 
required. 

 

 

STEP 6 
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Draw Stair        Design: 
 

This is final step before the stair diagram will be drawn. Check 
all the values are correct before continuing. If any compulsory 
values are empty you’ll be asked to amend this before 
completing the diagram. 
 

Click Draw Stairs to complete the form and draw the stair 
diagram to the canvas. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

STEP 7 
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MODULE: RAMP DESIGNS: 
 
 

Click the Function button to start the Ramp Design process. 
This will bring up a design form that will set the preferences for 
different features of the ramp diagram. There are 6 steps to 
complete. 
 

 
 
 

Ramp Type: 
 

Determine the type of ramp required in the diagram and click on 
the image to select it. Select from the following options: 
 
 

 

Type 
 

 

Description 
 

 

Single Ramp 
 

One straight ramp. 

 
 

Double Ramp - Straight 
 

 

Two ramp sections that continue 
in 1 straight line. 
 

 

Double Ramp - Corner  

 

Two ramps sections 90 or 
perpendicular to each other. 
 

 

Double Ramp - Parallel 
 

 

Two ramp sections 180 or 
parallel to each other. 
 

 
 

 
 
 

 

START 

 

STEP 1 



                   Chapter 7:     Modules  59 

Perspective: 
 

Determine whether the diagram is to have either a left or right 
perspective. Click on the image to select the required 
perspective. 

 

 
 
 
 

Ramp Values: 
 

Enter values for the width, length and height of the ramp. 
 

If drawing a double ramp, this page will appear twice, one for 
each section of ramp. The first ramp is the lower section and the 
second ramp is the upper section. 
 

Determine the gradient of the ramp through the values entered 
for the length and height values. For instance if the ramp 
gradient is to be 1:14 and the ramp length is 3000mm (or 3m) 
then calculate the ramp height to be 215mm (3000mm/14) and 
enter this into the height value. 
 

 

 
 
 
 
 
 
 
 
 
 
 

 

STEP 2 

 

STEP 3 
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Landings: 
 

If drawing a single ramp, enter the details for a bottom and top 
landing. If drawing a double ramp, enter details for a bottom, top 
and middle landing. 
 
The bottom and top landings are optional but the middle landing 
is required.  
 

 

Include landing 
 

If it is a bottom or top landing, 
determine if diagram is to include this 
landing. Uncheck the box below the 
image to exclude it. 

 
 

Enter Landing Values 
 

 

Enter values for the width and length of 
the landing. By default they will be the 
width of the ramp that was specified. 
 

 

Enter Offset Values  

 

If these values are set to 0 the landing 
width will be the same as the ramp. If 
the landing width is larger than the 
ramp, use these offset values to 
determine how much the landing will 
spill out on each side. 
 

 
 

 
 
 
 
 
 
 
 
 

 

STEP 4 
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Rail Options: 
 

This feature is only enabled for single ramps. Select the type of 
rail required and then enter the values for the far-side and near-
side rails that were selected.  
 

This feature is the same as the stair design process. See the 
Module: Stair Design section on page 52 for more details about 
how to enter values and features for these rails. 

 
 

Draw Ramp: 
 

This is final step before the ramp diagram will be complete. 
Check all the values are correct before continuing. If any 
compulsory values are empty you’ll be asked to amend this 
before completing the diagram. 
 
This design form can draw the ramp in 2 forms: Top View and 
3D View. Top View will draw the ramp as a plan, including all 
width and length measurements but won’t include any height 
measurements. 3D View will draw the ramp with a 3D 
perspective and will only draw the height and rail 
measurements. Select Top View, 3D View or both. 
 
Click Draw Ramp to complete your form and draw the ramp 
diagram to the canvas. 
 
 

 
 
 
 

 
 
 
 
 

 

STEP 5 

 

STEP 6 
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MODULE: INSERT PICTURE: 
 
 
The purpose of this module is to insert pictures, photos or images into the project 
and then draw straight onto these pictures. 
 
 

Phase 1: Insert and adjust the Picture 
 
Click the Function Button to insert a picture. A dialog box will appear to open the 
saved picture. Find the saved picture and click Open. 
 

 
 

If there is already a picture on the canvas you’ll be asked if you 
want to clear that image before proceeding. 

 
If the picture is larger than the canvas you’ll be asked if you want to 
automatically resize the image. This will mean the picture will fit 
within the canvas when scaled to 100%. 

 
 Rotate the picture clockwise by using then Select 

Tool, then right-clicking the picture and selecting 
either Rotate 90°, 180° or 270°. 

 
 

Phase 2: Draw to scale on the Picture 
 
After the picture is inserted, use any of the drawing tools to draw rails, shapes, 
dimensions, arrows and labels on the diagram. Pressing Clear Canvas will only 
clear these objects with the background picture remaining. Pressing Clear 
Canvas again will remove the picture as well. 
 
The Scale Factor for this diagram will have changed to a percentage since it’s 
impossible to know the size and scale of whatever is in the picture. 
 
However it is possible to set a relative scale for the picture. To do this, select the 
Measure Tool and measure something in the picture that you know an exact 
measurement of (eg: the height of a step). Enter this value in the Dimension Box 
and press enter. The scale is now set to this ratio. 
 
 
Please note:  
 
 
 
 
 

This is not an exact scale as the picture will have varying 
depths which affect the true scale of that part of the picture. 
However it will make the scale more comparable. 

Existing Image: 

Auto-Resize: 

Rotate Image: 
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OT Draw Support 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

TRIAL AND REGISTER OT DRAW: 
 
 
Perform the following steps to install, purchase and register OT Draw on your 
computer. 
 
 

1. Install Trial Version: 
 
You are entitled to install a trial version of OT Draw either by downloading or 
installing it from a CD. The trial period lasts for 14 days after installation. If 
downloading this trial version from the OT Draw website (www.otdraw.com) you 
will be asked to also download and install the Microsoft .Net Framework 3.5 
software if required. This software enables many features in the OT Draw 
program. The CD installation will automatically check and install this software 
from the disc. 
 
When purchasing OT Draw you must install the trial version and then unlock the 
trial by registering your product with the Product-Key. 
 
 

2. Purchase a licence to use OT Draw: 
 
Contact our sales team at sales@otdraw.com or visit our website to purchase a 
licence. A licence needs to be purchased for each computer that OT Draw will be 
installed on. 
 
After purchasing a licence you will be given a Receipt of Purchase and a Product 
Key. Use this Product Key to register and unlock the software. 
 
 
 
 

8 

http://www.otdraw.com/
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3. Register OT Draw: 
 
The trial version of OT Draw is unlocked by registering the product. To register 
OT Draw perform the following steps: 
 

 
 Internet connection is required to register OT Draw. 
 
 
 
Open the trial version of OT Draw. The initial splash screen will 
ask whether to continue the trial, purchase a licence or register 
OT Draw. Click Register OT Draw to be taken to our OT Draw 
Registration Website. 
 
 
Enter the Product-Key that was received with the Receipt of 
Purchase and press Confirm. You will be notified whether this 
Product-Key is valid and how many licences are still available. 
 
 
Enter your Contact Details and click Submit. We will provide you 
with information on updates and training based on your contact 
details. 
 
 
Download your OT Draw licence-key. This licence-key is a file 
specific to your computer and will unlock OT Draw on that 
computer.  
Save the licence-key to your OT Draw Folder. 
 

c:\Program Files\Insighted\OT Draw 
 
OT Draw is now registered and licenced for use on your 
computer. Contact us at support@otdraw.com if you are having 
any issues with this registration process. 

 
 
 

 

STEP 1 

 

STEP 5 

 

STEP 4 

 

STEP 3 

 

STEP 2 

mailto:support@otdraw.com
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AUTOMATIC UPDATES: 
 
 

Auto-Update Feature: 
 
OT Draw will automatically check to see if there are updated versions of OT Draw 
available to download and install. There needs to be an internet connection for 
this to occur.  
 
If there is an available update the following splash screen will appear. Click 
Update to be sent to our OT Draw Updates webpage or click Later to continue 
with current version. 
 

 
 
 

 
To install the update, download and run the installation file. It will automatically 
install the update. The current licence-key will remain active and you can reopen 
OT Draw to load the updated version of OT Draw. 
 
Installing updates will fix bugs, include new features and overall improve 
efficiency. 
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Auto-Update Settings: 
 
Use the Auto Updates Settings command in the Format menu to change the 
Automatic Updates options. Including the following settings: 
 

 

Setting 
 

 

Description 
 

 

Automatic Updates 
 

Determine whether OT Draw will automatically check 
for updates. Set this feature to OFF to disable this 
feature. 

 
 

Frequency 

 

 

Determine how often OT Draw will check for updates. 
This feature can be set to Daily, Weekly, Fortnightly or 
Monthly. The default is Weekly. 
 

 
 

 
 
 

Manually check for updates at any time by using the ‘Check For Updates’ option 
in the Help menu. 
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SUPPORT INFORMATION: 
 
 
For further support contact us at support@otdraw.com or visit the support page 
on our website www.otdraw.com/support.aspx. 
 
These links can be accessed from OT Draw by going to the help menu and 
selecting either the Email Support or Online Support options. 
 

 
 
 
Our website has frequently asked questions, support information and tutorial 
videos. 
 
 

 2011  Insighted Pty Ltd  ACN 145 077 532 
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